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Preface

Welcome to the Oracle Configurator Developer User’s Guide. This user’s guide includes
the information you need to work with Oracle Configurator Developer effectively.

Intended Audience

This guide assumes you have a working knowledge of your business processes,
tools, and your product configurations. It also assumes you are familiar with
product configurator applications. If you have never used configurator applications,
we suggest you attend one or more of the Oracle Configurator training classes
available through Oracle Education.

Structure

This documentation contains...

Introduction on page 1-1, which includes information on planning your project
to ensure your success in using Oracle Configurator Developer.

Constructing a Configurator on page 2-1, which includes information on
building model structure, configuration rules, and a user interface for an Oracle
Configurator window or SellingPoint application

Using Oracle Configurator Developer Tools on page 3-1, which includes the
vocabulary for understanding instructions for using Oracle Configurator
Developer.

Glossary of Terms on page Glossary of Terms-1

Glossary of Acronyms on page Glossary of Acronyms-1

xiii



Related Documents

For more information, see the following manuals in Release 11 of the Oracle
Product documentation set:

»  Oracle Configurator and SellingPoint Release Notes

»  Oracle Configurator and SellingPoint Administration Guide

»  Oracle Configurator Developer Tutorial

»  Oracle Configuration Interface Object (CIO) Developer’s Guide
»  Oracle Configurator Toolkit Developer’s Guide

»  Oracle SellingPoint Application Help

= Oracle Applications Release 11i documentation

This document generally refers you to the Oracle Configurator and SellingPoint
Administration Guide for additional information on database administration and
deployment topics. This is the administration guide appropriate for the fully
integrated Release 11i Oracle Configurator product. If you are working with the
Oracle SellingPoint Configurator, you should refer to Oracle SellingPoint Configurator
Administration Guide.

Conventions

Xiv

In examples, an implied carriage return occurs at the end of each line, unless
otherwise noted. You must press the Return key at the end of a line of input.

The following conventions are also used in this documentation:

Convention Meaning

Vertical ellipsis points in an example mean that information not
directly related to the example has been omitted.

Horizontal ellipsis points in statements or commands mean that
parts of the statement or command not directly related to the
example have been omitted

boldface text Boldface type in text indicates a specific key or screen name.

<> Angle brackets enclose user-supplied names.

[1 Brackets enclose optional clauses from which you can choose one or
none.



Convention

Meaning

>

The left bracket alone represents the MS DOS prompt.
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Introduction

Welcome to Oracle Configurator Developer

Oracle Configurator Developer (OCD) is the application development tool in the
Oracle Configurator family of products. Its convenient, drag-and-drop interface
enables rapid deployment of your configurator.

What is a Configurator

A configurator is a tool for configuring part or all of your products and services.
The configuration process can include assessing customer needs, selecting product
and service components and viewing configurations. A configurator enables end
users to access the parts that make up your product and the rules that govern how
those parts go together. With a configurator, end users can generate any custom
product configuration that the rules allow. By building a configurator, you bring the
expertise of your enterprise to the point of sale, dramatically changing and
improving the way your enterprise sells products and services.

The fundamental elements of a configurator built with Oracle Configurator
Developer are:

= aproduct model that captures the structure of your product

= configuration rules that constrain the relationships between parts of your
product.

= a user interface that reflects the model structure

These three elements make up a configuration model for your product. You
construct and maintain configuration models in Oracle Configurator Developer. A
single configuration model can be deployed to end users in a number of ways:

Introduction  1-1



Plan your Project

= as a stand-alone Oracle SellingPoint application, possibly in a mobile
environment

= as an Oracle Configurator DHTML window in a custom web application or in
iStore

= as aJava applet in Order Management, TeleSales or Sales Online

Building a Configurator with Oracle Configurator Developer

You can use Oracle Configurator Developer to build the Oracle Configurator Model
and Configuration Rules directly from your product and business requirements.
Oracle Configurator Developer automatically generates a functioning user interface
based on the product model and configuration rules you provide. You can
customize the default user interface to have the look and feel that you want for your
enterprise.

Oracle Configurator is integrated with Oracle Applications so that an end user can
configure a product based on an Oracle Bill of Materials. Oracle Configurator
dynamically creates a configuration model that reflects the BOM rules: parent-child,
optional or required selections, mutually exclusive selections and quantity cascade
rules. If you wish to add additional model structure to the BOM Model, or add
additional rules, or customize the user interface, you must do that work in Oracle
Configurator Developer.

A Project is the workspace where you construct a configuration model. All the data
that define your configuration model are stored in real time directly in the Oracle
Configurator schema. Any Oracle Configurator Developer Project must be
associated with a datasource for an Oracle Configurator schema, which is a schema
of tables named with the CZ_ prefix standalone or in the Oracle Applications
database.

Plan your Project

Before you open a Project and begin work in Oracle Configurator Developer, you
need to plan your configurator project carefully. Here are some points you should
consider during planning. For additional warnings and helpful hints, see the Oracle
Configurator and SellingPoint Release Notes.

= Plan on attending a training course in using Configurator Developer.

= Plan to meet all platform requirements for Oracle Configurator Developer and
your Oracle runtime configurator as presented in the Oracle Configurator and
SellingPoint ReadMe on the Configurator Developer CD.

1-2 Oracle Configurator Developer User’s Guide



Plan your Project

Plan on setting up your Configurator Developer users on a local area network
(LAN). Do not attempt to connect Configurator Developer clients to a database
running on a remote server over a wide area network (WAN), T1 connection, or
modem due to performance issues. A WAN configuration may be practical if
the network bandwidth is high enough. However, in many situations, it will be
necessary to run Configurator Developer remotely using a Citrix server
collocated with the database server.

Plan to build your entire configuration model in a single Project. There is no
automated procedure for merging several smaller Projects into a single larger
one.

Plan to define your product model first, before defining rules.

Establish standardized and meaningful naming conventions for Model nodes
and Rules. Use meaningful names for Components and Options. Names like
Response 1 and Response 2 can easily lead to confusion.

Plan to express your requirements for valid configurations in terms of the rules
that Oracle Configurator Developer provides.

Plan to write end user Help for the Oracle runtime configurator and the
configuration models you deploy there, if necessary. Help in the Oracle runtime
configurator is not context-sensitive. It provides Help for the window, not for
individual content items.

Plan your user interface. If you plan to deploy your configuration model as a
DHTML window, design a template to contain the Configurator frameset at
runtime; the colors, banners, Done and Cancel buttons, and Help if desired.
Sample HTML files for a template that you can customize are installed as part
of your Oracle Configurator Toolkit installation (%ORACLE_
HOME?%\OSP\WebUI).

Plan to publish both test and production versions of your projects manually. In
addition, note that it is difficult to update a model that is in production. See the
Oracle Configurator and SellingPoint Administration Guide for a list of tables that
must be updated from one version to another.

Gather the requirements for needed outputs such as quotes, proposals, and
order entry data, their format, and the data for populating them. Oracle
Configurator provides pre-defined output for quotes, proposals, and Oracle
ERP orders.

Gather the requirements for integrating your system with other systems such as
data synchronization and replication, quotes, and orders
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Design your Configuration Model

= Determine your requirements for deployment beyond those stated in the Oracle
Configurator and SellingPoint ReadMe on the Configurator Developer CD, such as
networked client/server PCs or mobile laptops.

Multi-User Development Strategy

If you need to have more than one developer working on a Project, consider the
following suggestions.

= You can work in numerous Projects on a single Oracle Configurator schema, all
sharing the same Item Master. As mentioned in the previous section, this is not
a recommended strategy for developing a single configuration model, because
merging of the Projects must be done manually.

= To construct your configuration model efficiently, have only one user at a time
make changes to the Item Master for your Project. If more than one user is
accessing a Project and making changes, they are doing so directly into a
database, so last one in prevails!

= Define all of the Model structure first, before building Configuration Rules.

= When the Model structure is complete, coordinate the rule definition activities
so different developers are working on different, non-overlapping parts of the
structure.

Design your Configuration Model

You also need to do the basic design work for your configuration model. You need
to consider what functionality your end users require. For example, you may need
to add a customer needs assessment component. You must also consider what rules
you need to build into your configuration model. Ask yourself questions like, What
components must be included in a valid configuration? What components are
optional? What sub-components are compatible with each other? The design step
may include writing a functional specification and other design documents.

Identify your Product Data

Oracle Configurator Developer requires that an Oracle Configurator schema be
identified as the datasource for every Project you define. You must populate the
Oracle Configurator schema Item Master with enterprise data needed for product
configuration. To this end, you need to identify the source of your product data and
structure. If your data comes from Oracle BOM, identify which bills to import into
Configurator.

1-4 Oracle Configurator Developer User’s Guide
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If your data comes from Oracle Inventory item data, or from an external data
source, you must develop a mechanism for populating the Configurator import
tables, and a plan for refreshing the import as required. Your Database
Administrator (DBA) may prepare existing enterprise data for import. If property
data is imported from Oracle as part of the standard BOM import, properties and
their values must be represented as Catalog Descriptive Elements and Descriptive
Element Values in Oracle Inventory.

For data that is not imported, the configurator project team manually populates the
Oracle Configurator schema Item Master within Oracle Configurator Developer.

For more information about preparing and importing data, see the Oracle
SellingPoint Configurator Administration Guide or your DBA. For information on
setting up a datasource for Configurator Developer to connect to, see the
ReadMe.pdf on the Oracle Configurator Developer CD.

For information about working with Oracle Configurator Developer Projects, see
Managing an Oracle Configurator Developer Project on page 2-2.

Design your Configuration Rules

Your first step toward constructing Configuration Rules is to think about how the
products and services you sell go together. Some combinations add up to something
you can sell, while others do not. When you build configuration rules in Oracle
Configurator Developer, you put that product knowledge into your configurator.

Here is a list of some of the issues you need to consider before building
configuration rules.

= determine whether a selection affects another item or selection
= identify any options that are used as default initial selections
= define the rules governing the configuration of product families

= define the relations among product families

Quick Tour of Oracle Configurator Developer

Oracle Configurator Developer consists of the following modules, which address
different aspects of constructing and testing configurator functionality.

= Model Module on page 3-17
= Configuration Rules Module on page 3-24
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= User Interface Module on page 3-29
s Test/Debug Module on page 3-35

The Model, Configuration Rules, and User Interface modules present you with
menus of commands and views of the configuration model you are building. The
Test/Debug module launches a selected testing environment.

Getting Help with Oracle Configurator Developer

Help for Oracle Configurator Developer is available from the Help menu in the
menu bar and as the Oracle Configurator Developer User’s Guide.

Product Support

The mission of the Oracle Product Services organization is to help you resolve any
issues or questions that you have regarding Oracle Configurator Developer, Oracle
Configurator, and Oracle Configurator Internet Edition.

For a complete listing of available Oracle Product Services, see
http:/ /www.oracle.com/support/welcome. For support phone numbers, see
http:/ /www.oracle.com/support/contact_us.

Oracle metals subscribers should call the number for their level of support.
OracleGOLD customers, please call (800)440-4653. OracleSILVER customers, please
call (800)223-1711. OracleBRONZE customers, please call: East (407)240-8900,
Central (719)635-8900, West (650)506-1500.
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Constructing a Configurator

The Oracle Runtime Configurator

The Oracle runtime configurator is a generic configurator, as described in What is a
Configurator on page 1-1. With Oracle Configurator Developer, you build a Model,
Configuration Rules, and User Interface structure that reflect your enterprise and
your end users’ requirements. The Model, Configuration Rules, and User Interface
structure underlying the application are stored in the Oracle Configurator schema
and can be replicated to the Oracle Configurator Mobile Database.

The Active Model interprets the data in the Oracle Configurator schema and
enforces valid configurations based on end user selections. The Active User
Interface interprets the data in the Oracle Configurator schema and keeps the Ul
state current as the end user works. In other words, when the end user works in the
Oracle runtime configurator, the Oracle Configurator schema, the Active Model,
and the Active UI determine what is available for selection, what results from
selections, and how it is displayed.

Configurator Developer provides a generic structure, and a look and feel for the
Oracle runtime configurator that is enforced by the Active Model, Active Ul, and
Oracle Configurator schema. This generic user interface can be customized, see
Customizing the Generic User Interface on page 2-62.

The application you create with Oracle Configurator Developer can be deployed as
= an Oracle SellingPoint application

= an Oracle Configurator window: Dynamic HTML in a browser

= an Oracle Configurator window: Java applet in a browser.

Further information on these deployment options is available in the Oracle
Applications Help system. See Oracle Configurator and SellingPoint Administration
Guide for more information on the mechanics of deployment.

Constructing a Configurator 2-1



Managing an Oracle Configurator Developer Project

Managing an Oracle Configurator Developer Project

You start constructing your Oracle Configurator configuration model by defining a
Project in Oracle Configurator Developer. The Project is the workspace in which
you build your configuration model. The Project uses data stored in the Oracle
Configurator schema which you have identified as the data source for your Project.
You may organize your project team to work on several Oracle Configurator
Developer Projects in parallel, all accessing a common Oracle Configurator schema.
However, only one implementer should work on any one part of the [tem Master or
Model structure at a time. For information on how to ensure that the Oracle
Configurator schema contains the data you need, see the Oracle Configurator and
SellingPoint Administration Guide or your DBA. You can combine the work done on
several Projects into one at any time, as long as you are working with a single
Oracle Configurator schema.

Each Project corresponds to a configuration model. When you are working in a
Project, all changes you make are stored immediately in the Oracle Configurator
schema, so you do not need to explicitly save your work.

To save versions of a Project, select File/Save Project As... and give a unique name
for each version. If the Project contains imported BOM Model structure, all refresh
actions are applied to the original Project only. You must modify the Oracle
Configurator schema before you can refresh the copied Project from the original
BOM Model. The documentation on Refresh and Update in the Oracle Configurator
and SellingPoint Administration Guide describes how to make the necessary
modifications to refresh a copied Project.

Do not use File/Save Project As... to publish versions such as development, test,
and production. Save Project As... saves the Project, not the database. See Oracle
Configurator and SellingPoint Administration Guide for information on publishing the
database.

The Overall Process
There are two approaches to working in Oracle Configurator Developer:
= self-contained mode
= integrated mode

If you are working in the self-contained mode, create the Item Master, and build
your Model, Rules, and User Interface entirely within Configurator Developer. You
can chose to work this way if you are building a small-scale demo or prototype
system. Many real-world configuration models involve working in the integrated
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mode. You build a configuration model based on product structure and data from
an Oracle Bill of Material. End users configure products defined in your Oracle
BOM, and pass completed product configurations on to Oracle Order Management.
To build such a configuration model, you begin by importing BOM data into the
Oracle Configurator schema. The Oracle Configurator and SellingPoint Administration
Guide describes the data import process.

All the tools you need to construct the core functionality for an Oracle runtime
configurator are available in Oracle Configurator Developer. The database you use
during construction is the Oracle Configurator schema. This construction or
development version of the Oracle Configurator schema is subsequently replicated
into a testing and production version.

The BOM data import process creates an Oracle Configurator Developer Project.
Open this Project to begin development. A BOM Model and Item Master are
available to you in the Project. You cannot modify the imported BOM Model, but
you can add structure to the Product node that is parent to the BOM Model. If you
are working in the self-contained mode, you begin development by opening a new
Project and creating a Model.

After you have completed your Model structure, you create Configuration Rules
that define how the parts of the Model are related to each other. After you have
created Configuration Rules, you use Oracle Configurator Developer to generate a
User Interface that reflects the structure of your Model. This generated interface
enables you to test the functionality of your Model and Configuration Rules in the
Test/Debug module, without doing any additional user interface development.
When you are satisfied with the performance of Model and Rules, you can
customize the generated User Interface to meet your requirements.

These steps are described in more detail in the following sections:
»  The Project on page 2-4

»  The Item Master on page 2-5

= The Model on page 2-7

= The Configuration Rules on page 2-20

»  The User Interface on page 2-57

s Test/Debug on page 2-73
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Language Support in Oracle Configurator

The Project

The user interface for the Oracle Configurator Developer itself is in the English
language only. Oracle Configurator Developer does support Models and User
Interfaces in languages other than English, if the computer operating system is
installed in the target language. For example, if you run Oracle Configurator
Developer and the operating system of the computer Oracle Configurator
Developer is running on is installed in French, you can create Features, Options,
Totals, and so on, with names and descriptions in French.

When you build the Ul, you can make labels for fields in French, and when the end
user runs the configurator, those labels appear in French. If the end user needs to
input text in the configurator, the only language available is English.

When you start Oracle Configurator Developer you log in and select your data
source. For details about logging in and setting up the data source, see the
ReadMe . pdf file on the Oracle Configurator Developer CD and the Oracle
Configurator and SellingPoint Administration Guide. Configurator Developer then
opens the New Project dialog where you can create a new Project or open an
existing Project. When you are working with imported BOM, the import process
creates a Project which has the same name as the root node of the imported BOM
Model. Select and open this Project.

Opening an Existing Project

1. Select the Existing tab on the Open Project dialog when you start Oracle
Configurator Developer. If you are running Configurator Developer, select
Open Project from the File menu.

2. Select the desired Project from the list of the existing Projects and their
descriptions or type the name of the desired Project in the Name field.

3. Select OK.

Creating a New Project

You create a new Project if you are using Oracle Configurator Developer in
self-contained mode. You use self-contained mode if you are creating a demo or
prototype application or building a configuration model based on imported data in
the Item Master, rather than imported BOM structure.
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1. Select the New tab on the New Project dialog when you start Oracle
Configurator Developer or select New Project from the File menu.

2. Type the name you want to give the Project in the Name field.

3. Type a description of the Project, such as which product or service the Project is
set up for, in the Description field.

4. Select OK.

The ltem Master

The Oracle runtime configurator uses a standard schema for configuration data
referred to as the Oracle Configurator schema. The Item Master is a subschema of
the Oracle Configurator schema that contains product data. The Item Master
consists of Items, which are specific elements of a product, and Item Types, which
are logical groupings of items. You can view the Item Master by Item Name or by
Item Description, and you can choose whether or not to view items grouped by
Item Type. In most development situations, Item Master data is imported.

Oracle Configurator Developer provides a mechanism called Populators to link
data items in the Item Master to the Model. Populators allow you to quickly update
your Model to reflect changes in product data. See Using Populators on page 2-17.

Importing Data into the ltem Master

Product data is typically imported into the Oracle Configurator schema from data
sources external to Oracle Configurator. Legacy product data, such as Bills of
Material or Pricing information, can be imported into the Item Master. Generally,
the data sources are either a specific Oracle Applications database or a non-Oracle
Applications database.

Oracle Configurator imports non-Oracle Applications databases by loading ASCII
text files into Oracle Configurator Import Tables. In order to load an ASCII file into
the Import Tables, your legacy data must be in the correct format to populate the
Database. You must create custom scripts to extract legacy data in the format
required by the Import Tables. Consult the discussion of Generic Import in the
Oracle Configurator and SellingPoint Administration Guide for more information on
import of data from non-Oracle databases.

When you import data into the Item Master from Oracle Applications, Oracle
Configurator provides
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= scripts which create Extraction Views to populate the Oracle Configurator
Import Tables

= concurrent programs for transferring the data within the Oracle Applications
database in which the Oracle Configurator Database CZ_ schema exists.

Once the Oracle Configurator schema is populated with imported data, that data is
available to Oracle Configurator Developer and the deployed Oracle runtime
configurator. Oracle Configurator Developer automatically populates the Model
Tree and the Item Master Structure with the imported BOM data. The part of the
Model based on imported data cannot be altered in Oracle Configurator Developer.
You can add additional Components, Resources, Totals, and so on to the Model to
complete your configuration model requirements.

When you import an Oracle BOM Model, defined Catalogs are imported as Item
Types. Catalog Descriptive Elements and Descriptive Element Values are imported
as item Properties and Property values. You can also manually create data Items
and Item Types in the Item Master for special purposes required by your
configuration model. Added elements cannot be transferred back to the BOM
schema to update the BOM.

The Oracle Configurator imports the following data directly from Oracle
Applications.

s Bills of Material structure
s Associated Item Master information

For detailed information on importing data into the Item Master, see Oracle
Configurator and SellingPoint Administration Guide.

Modifying the ltem Master

You can add, edit, or delete Items, Item Types, or Properties associated with Item
Types.

Adding a New ltem Type
1. Select the top-level node in the Item Master tree.

2. Select New Item Type from the Create menu or use the right mouse button to
select New Item Type from the pop-up menu.

3. Enter the Name on page 3-23, Description on page 3-23, and Properties on
page 3-24 for the new Item Type.
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Adding a New Item
1. Select an Item Type.
2. Select New Item from the Create menu or use the right mouse button to select

New Item from the pop-up menu.

Enter the Name on page 3-23, Description on page 3-23, and Type/Properties
on page 3-23 for the new Item.

Changing the ltem Type of an ltem

1.
2.
3.

Select an Item.
Select the Change button in the Type/Properties area of the Attributes View.

The resulting dialog box allows you to select a new Item Type for the Item, or to
create a new Item Type.

Repeat steps 1 through 3 for each Item whose Item Type you want to change.
This is the only way to change the Item Type of an Item.

Editing an Item or Item Type

1.
2.

Select the Item or Item Type that you want to edit.

Edit the information you want to change in the Attributes View. The Item
Master is updated with the new information.

Deleting an ltem or ltem Type

1.
2.

The Model

Select the Item or Item Type you want to delete.

Select Delete from the Edit menu or use the right mouse button to select Delete
from the pop-up menu.

Select OK to confirm the deletion.

Constructing the Model structure is your first task in creating a configuration
model. Importing Oracle BOM information creates an imported BOM Model in a
Project. You can create additional structure to extend the Model to include
additional aspects of your configuration problem. This added structure does not
appear in the Java applet user interface.
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When you build a Model, you are translating your knowledge about how parts are
configured into the products you sell, into terms that Oracle Configurator
Developer, and ultimately the Oracle runtime configurator, can use. The Model is
organized into a hierarchy called a tree. The object types that the Configurator
Developer provides to build your Model are Product, Component, Feature, Option,
Resource, and Total, as well as BOM Model, BOM OptionClass, and BOM
StandardItem imported from an Oracle BOM.

Model The highest level of structure within the Project. A
Model can contain Products.

Product The highest level of configurable structure within
the Model. The goal of your sales process is to
configure one of these. A Product can contain
Products, Components, Features, Resources, and

Totals.

Component A configurable part of a Product. A Component can
contain Components, Features, Resources, and
Totals.

Feature A Feature can be a List of Options, an Integer

Number, a Decimal Number, a True/False value, or
a Text value. A Feature of type List of Options can
contain Options.

Option An Option is part of a List of Options in a Feature. It
is often an object represented by an item in the Item
Master.

Total A Total keeps track of a quantity. A Total can have a

positive or negative value. Use Numeric Rules to
contribute to and consume from Totals.

Resource A Resource also keeps track of a quantity. The value
of a Resource can be positive or 0, but a Resource is
violated if its value is negative. Use Numeric Rules
to contribute to and consume from Resources.

BOM Model Equivalent to a Component
BOM OptionClass Equivalent to a Feature
BOM StandardItem Equivalent to an Option
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Properties

Model nodes can also have Properties. A Property of a node has a specific value that
describes an instance of that node, but is not itself a selectable item in a
configuration. Examples of common Properties are weight, diameter, and voltage.
The values of Properties are used in Configuration Rules. See Building Comparison
Rules on page 2-34 and Building Property-based Compatibilities on page 2-35.

In order to import properties as part of an imported BOM Model, the properties
must be defined as Descriptive Elements and Descriptive Element Values in
appropriate Catalogs associated with the Oracle BOM.

For those portions of your model constructed directly in Oracle Configurator
Developer, you can add, delete, and edit Properties directly on nodes of the Model,
or you can add Properties to Items in the Item Master. When you add or delete a
Property of a node in the Model, you affect only the selected node. This is in
contrast this to Properties in the Item Master, where additions and deletions affect
all Items of the selected Item Type. When you use an Item or Item Type in your Item
Master to create a node in your Model, for example, by using a Populator, the
Model node always reflects all the currently defined Properties and Property values
of the originating node in the Item Master. These inherited Properties cannot be
deleted or edited in your Model. Properties that you define directly in your Model
do not affect your Item Master.

Properties on page 3-22 describes how to add, edit, and delete properties. Manage
Properties on page 3-9 describes how to work with properties on a project-wide
basis.

The Properties you define in the Item Master or the Model are User Properties. User
Properties are unique attributes that you define specifically for your Project.
Properties in the Item Master are associated with an Item Type. If you change the
Type of an Item the Item loses its old Properties and acquires the Properties
associated with the new Type.

Nodes in the Model also have System Properties. System Properties are attributes of
the selected node that are specific to certain types of nodes and are provided by
Oracle Configurator Developer for you to define. The System Properties that you
can define are:

S